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12.1 Try to Write Recipe Data in Device/PLC

[Action Example]

Detect the rising of the trigger device (bit device: "M01") of Device/PLC and write recipe sheet data created in 

Excel into 5 devices (word device: address "D50" to "D54") of Device/PLC.

(Example) Writing the data of record No. "1" of a recipe sheet.

This section describes the setting procedures for executing the above action (ACTION) as an example.

PC
(Node Name: PC1)

Device/PLC
(Device Name: PLC1)

 Device Data

D50
D51
D52
D53
D54

10

30
40

20

50

GP3000
(Node Name: AGP1)

 Bit device 
"M01" ON!

No. of Records
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[Setting Procedure]

11 Executing ACTION (page12-29) This step verifies that recipe data is written in the 
specified area of Device/PLC when the preset trigger 
condition has become effective.

10 Transferring a Network Project File (page12-
29)

This step transfers a saved network project file to the 
display unit.

9 Saving a Network Project File (page12-28) This step saves the current settings as a network 
project file and reloads.

8 Verifying Setting Result (page12-26)t This step verifies setting results on the setting 
content list screen.

7 Setting ACTION Node/Process Completion 
Notification (page12-24)

This step sets the name of an ACTION node and the 
alert setting whether it should be tuned on or off 
when the ACTION is completed.

6 Setting the Contents of a Recipe Sheet 
(page12-11)

This step sets the following items:
• Set a writing device
• Set the area to read out

5 Specifying a Recipe Sheet and its Output File 
(page12-8)

This step sets the following items:
• Specify a recipe sheet
• Specify an output file

3 Registering Entry Nodes (page12-5) This step registers the PC and the display units as 
entry nodes.

1 Creating a Recipe Sheet (page12-4) This step creates a recipe sheet in 'Microsoft Excel' 
to write in Device/PLC.

2 Starting 'Pro-Studio EX' (page12-5) This step starts 'Pro-Studio EX'.

4 Registering Symbols (page12-6) This step registers as a symbol the device of Device/
PLC to write data in.
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12.1.1 Creating a Recipe Sheet

This step creates a recipe sheet where data to write in Device/PLC exists. 

1 Start 'Microsoft Excel' and create the recipe sheet below in Sheet 1.

[Creation Example]

Leave both spaces for "Symbol Name" (Cells B1 to F1) and those for "Record No." (Cells A2 to A4) blank for 

these will be automatically allotted and filled in after completing the setting.

2 Save the recipe sheet with the file name "recipe.xls" on PC desktop after creating.

• You can prepare multiple recipe data on Excel.

Allot a record No. for each recipe to specify data to write in Device/PLC. For details, refer to 

"12.1.6 Setting the Contents of a Recipe Sheet" mentioned later.

• You can create a recipe sheet in the direction (horizontal) as shown below. 

Recipe data

"Symbol Name" insert field

"No. of Records" insert field

Recipe data"Symbol Name" insert field

"No. of Records" insert field
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12.1.2 Starting 'Pro-Studio EX'

This step starts 'Pro-Studio EX'.

Refer to "3 Trial of Pro-Server EX" for details about starting method.

12.1.3 Registering Entry Nodes

This step registers the PC and the display unit connected with network as nodes.

Refer to "31 Node Registration" for details about entry nodes.

Entry node Setting item Setting example

PC
Node Name PC1

IP Address 192.168.0.1

Display Unit

Type GP3000 series

Node Name AGP1

IP Address 192.168.0.100

Node Name  :PC1

IP Address  :192.168.0.1

Node Name  :AGP1

IP Address  :192.168.0.100

Device/PLC Information
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12.1.4 Registering Symbols

This step registers as a symbol the device address of Device/PLC to which device data is written.

Refer to "32 Symbol Registration" for details about symbols.

Device 

Address

M01 Start writing

Symbol

Trigger (Trigger Condition)

Writing Device

 Device 

Address

D50

D51

D52

D53

D54

PLC1 Data

Symbol

Device 

Address

D10 Store record No.

Symbol

Record No. storage



Try to Write Recipe Data in Device/PLC

Pro-Server EX Reference Manual 12-7

• Trigger (Trigger Condition)

• Record No. storage

• Writing Device

Setting item Setting content

Symbol Name Start writing

Data Type Bit

Device address for 
symbol registration

"01" of Device/PLC (PLC1)

No. of Devices 1

Setting item Setting content

Symbol Name Record No. Storage

Data Type 16Bit (Unsigned)

Device address for 
symbol registration

"10" of Device/PLC (PLC1)

No. of Devices 1

Setting item Setting content

Symbol Name PLC1 data

Data Type 16Bit (Signed)

Device address for 
symbol registration

"D50" to "D54" of Device/PLC (PLC1)

No. of Devices 5
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12.1.5 Specifying a Recipe Sheet and its Output File

This step specifies the pre-created recipe sheet and its output file.

Refer to "12.3 Setting Guide" for more details.

1 Click the [Feature] icon on the toolbar.

2 Select [ACTION] from the tree display on the left of the screen, then click the [Add] button.

Setting item Setting content

Specify a Template Template File
C:\Documents and 
Settings\Administrator\Desktop\recipe.xls

Output File

Folder Name C:\Documents and Settings\Administrator\Desktop

File Name Recipe write.xls

Start with the output 
file displayed

Not checked

Do not save the output 
file when ACTION 
runs.

Not checked
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3 Click the [ACTION Type] list button, and select "Create form using Excel". 

Then, enter the name of ACTION to set in the [ACTION Name] field. In this example, enter "Recipe Write".

4 Click the [Click here to set the ACTION parameter] button.

• [ACTION Name] can be an arbitrary name.
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5 Make settings regarding an Excel template and its output file.

1) Click the [Reference] button of [Template File] to set the template file "templete.xlt" which you created.

2) Click the [Reference] button of [Folder Name] and specify "Desktop" as a folder to save the output file.

3) Set the file name "Recipe Write.xls" in the [File Name] field for the output file to set.
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12.1.6 Setting the Contents of a Recipe Sheet

This step sets the contents of a recipe sheet for writing data to Device/PLC.

The example below shows the setting of data write area (recipe area) of a recipe sheet.

Refer to "12.3 Setting Guide" for more details.

1 Click the [Edit Template] button.

The recipe sheet appears. 

Setting item Setting content

Entry Node AGP1

Device Name PLC1

Device Address/Symbol 
Group

PLC1 data

Add Device Address/
Symbol Name

Checked

Target Cell Range A1 to F4

Data Direction Specify the direction of record No.s as "Vertical".

Trigger Condition Name Turn on write start bit

Trigger Condition When "Start writing" (M01) is ON

Target Cell Range

Data direction

Device address/Symbol name 

will be displayed.

Record No. will be inserted.
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2 Set a data write area.

1) Click the [Recipe Area] icon on Excel.

2) Click the list button of [Node] and select "AGP1" as a data transfer destination node.

3) Click the list button of [Device Name] and select "PLC1" as a data transfer destination device.

• Selecting "Recipe Area" from [Excel Action] of the menu displays the same screen. 
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4) Click the list button of [Device Address/Symbol Group] and select "PLC1 data" as a symbol of the data to 

write in.

The device number "1" will be automatically entered in [No. of Devices], and "16Bit(Signed)" in [Data Type].

5) Check [Add Device Address/Symbol Name].

• After the procedure of "12.1.9 Saving a Network Project File" described later, open the template 

again, and open the recipe setting dialog box. After confirming that the "Add Device Address/

Symbol Name" checkbox has been checked, click the [OK] button. Then, the device address/

symbol name will be reflected in the template.



Try to Write Recipe Data in Device/PLC

Pro-Server EX Reference Manual 12-14

6) Click the cell range specify button of [Target Cell Range].

7) Drag the mouse to specify the data write area (cells A1 to F4). Then click the [OK] button.

8) Select "Vertical" of [Data Direction]. 

• When specifying the area, cover the cells to insert record No.s and Device Address/Symbol Names. 
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9) Click [Allot Record No. from 1 to Cell Range].

Record No.s and ruled lines are automatically added on the recipe sheet.

• Specify the recipe data to write in Device/PLC with record No.s. This example allots record No.s to 

the recipe data.
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3 Specify a record No. 

Specify the recipe data by entering a record No. in the symbol "Record No. storage" from display unit or Device/

PLC. 

(Example) In case of storing device data "1" in the device "Record No. storage".

1) Click the [Record No. Settings] tab.

2) Click "Specify by device/symbol values" in [Record No. at Write Recipe].

• If you select [Specify by cell value], specify any cell on Excel. The number entered in the cell is 

recognized as the record No.

Refer to "12.3 Setting Guide" for more details.

10
20
30
40
50

D10 1

Record No. storage D50
D51
D52
D53
D54

 Device data

Write data of record No. "1" 
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3) Click the list button of [Node] and select the node name "AGP1" which has the Device/PLC to store the 

record No.

4) Click the list button of [Device Name] and select the Device/PLC "PLC1" to store the record No.

5) Click the list button of [Device Address/Symbol] and select the symbol name "Record NoStorage" of the 

device to store the record No.

The device data type "16Bit(Unsigned)" will be automatically entered in [Data Type].
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4 Set trigger conditions. 

1) Click the [Trigger Condition Settings] tab.

The "Trigger Condition Settings" screen will appear.
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2) Click the [New Trigger Condition] button.

3) Click the [New Trigger Condition] button.

4) Enter the trigger condition name "TurnOnWriteStartBit" in [Trigger Condition Name], and select "AGP1" in 

[Node Name] as a name of the data transfer source. 

• You can also activate ACTION by placing a button on Excel from [New Trigger Button] and 

clicking it. Refer to "12.3 Setting Guide" for more details.



Try to Write Recipe Data in Device/PLC

Pro-Server EX Reference Manual 12-20

5) Click the [When Device ON] button in the [Condition 1] tab and select "PLC1" for the device name. 

6) Click the [Device Address] list button and select "WriteStart" for the device symbol name which serves as the 

trigger. 

[Data Type] automatically appears after selection, too. 
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7) Click the [OK] button.

8) Click the [Close] button.

9) Click the blank line of [Write] and select "TurnOnWriteStartBit" as a trigger condition.
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10) Click the [OK] button.

11) Click the [OK] button.

This is the end of the content settings of a recipe sheet.

• Here the dialog box will appear because no network project file is loaded to 'Pro-server EX'. This is 

not a problem, however.

The file will be loaded in "12.1.9 Saving a Network Project File" mentioned later.

• Can display Data/Time on an Excel sheet. 

"5.2 Writing Date/Time in a Form"

• Can display arrows on an Excel sheet. 

"5.3 Writing Arrows in a Form"

• Can display a trigger source node on an Excel sheet. 

"5.4 Writing Trigger Source Node Names in a Form"
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5 Close 'Excel'.

The following dialog box will appear, asking you if you want to save changes before closing. Click the [Yes] 

button.

6 On the "Create form using Excel" screen, click the [OK] button.
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12.1.7 Setting ACTION Node/Process Completion Notification

This step sets the name of an ACTION node and the alert setting whether it should be tuned on or off when the 

ACTION is completed.

• ACTION Node : PC1

• Receive Notification: OFF

1 On the "Set ACTION Name/Parameter" screen, click the [Next] button.

2 Click the list button of [ACTION Node] and select "PC1" as a node where ACTION operates.
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3 Turn off the [Receive Notification Exists] check box, if checked.

4 Click the [Complete] button.

The "Set ACTION Node/Process Completion Notification" screen will disappear. On the left of the screen, the 

name of ACTION you set will appear.

This is the end of the settings of the ACTION node and process completion notification. 

• Do not check "Receive Notification Exists".



Try to Write Recipe Data in Device/PLC

Pro-Server EX Reference Manual 12-26

12.1.8 Verifying Setting Result

This step verifies setting results on the setting content list screen.

1 Select the ACTION name "Recipe Write" from the tree display on the left of the screen.

Confirm that the setting content appears on the right of the screen.

• With the "Excel Report" ACTION, you cannot add, edit or delete a trigger condition in "ACTION-

specific Trigger Condition/Process List". To change a preset condition, click the [Set Parameter] 

button, and select [Edit Template] to change data on Excel.
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2 Select the trigger condition name "TurnOnWriteStartBit" from the tree display on the left of the screen.

Confirm that the setting content appears on the right of the screen.

This is the end of the verification of the settings.
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12.1.9 Saving a Network Project File

This step saves the current settings as a network project file and reloads to 'Pro-Server EX'.

Refer to "25 Saving" for details about saving a network project file.

• Path of network project file : Desktop\monitor.npx

• Title : EXCEL Report ACTION

12.1.10 Test Write

You can check if the settings are correct before transferring a created network project file to entry nodes.

1 Click the [Feature] button.

2 Click "ACTION" from the tree display on the left of the screen, then click the [Edit] button.

3 On the "Set ACTION Name/Parameter" screen, click the [Click here to set the ACTION parameter] button.

4 On the "Create form using Excel" screen, click the [Edit Template] button.

• 'Pro-Server EX' reads a created network project file, and then executes ACTION 
according to the settings in the file. The settings therefore need be saved in the network 
project file.

• Be sure to reload the network project file to 'Pro-Server EX' If not, ACTION will not work.

• You do not necessarily have to perform a test write.

If you skip this, proceed to "12.1.11 Transferring a Network Project File".

• Note that the data will be actually written in the Device/PLC when you specify the device 
of Device/PLC as a write destination.

• To perform a test write, it is necessary that 'Pro-Server EX', to which a created network 
project file has been loaded, is running.
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5 With the ACTION area selected, click the [Test Write] icon.

At this point, data is written in the Device/PLC.

12.1.11 Transferring a Network Project File

This step loads a saved network project file to 'Pro-Server EX' and then transfers to entry nodes.

Refer to "26 Transferring" for details about transferring a network project file.

12.1.12 Executing ACTION

This step verifies that enabling a trigger condition activates ACTION and writes the data of the recipe sheet (File 

name: "Recipe write.xls") to the specified device of Device/PLC.

This is the end of the explanation of this ACTION.

• You can check that data is being written on the "Symbol Monitor" screen of "Status Monitor". For 

more details, refer to "28 Simply Confirming On-site Status".

• Refer to "12.4 Restrictions" for details about the restrictions on test writes.

• Be sure to transfer a network project file. If not, ACTION will not work.

• You can check the write/read status using the symbol or device monitor. For more details, refer to 

"28 Simply Confirming On-site Status".

• If error occurs, you can check the log in the Log Viewer. For more details, refer to "28.5 

Monitoring System Event Logs".

• If you want to achieve faster communication during ACTION, refer to "29 Tips for Faster 

Communication".
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12.2 Modifying Recipe Data from the Actual Values

[Action Example]

Detect the rising of the trigger device (bit device: "M01") of Device/PLC and read out the data of 5 devices (word 

device: address "D50" to "D54") of Device/PLC to an Excel recipe sheet.

(Example) Reading out the data to record No. "1" of a recipe sheet.

This section describes the setting procedures for executing the above action (ACTION) as an example.

PC
(Node Name: PC1)

Device/PLC
(Device Name: PLC1)

 Device Data

D50
D51
D52
D53
D54

10

30
40

20

50

GP3000
(Node Name: AGP1)

 Bit device 
"M01" ON!

No. of Records
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[Setting Procedure]

11 Executing ACTION (page12-58) This step verifies that the data of Device/PLC is 
written in the specified area of a recipe sheet when 
the preset trigger condition has become effective.

10 Transferring a Network Project File (page12-
58)

This step transfers a saved network project file to the 
display unit.

9 Saving a Network Project File (page12-57) This step saves the current settings as a network 
project file and reloads.

8 Verifying Setting Result (page12-55) This step saves the current settings as a network 
project file and reloads.

7 Setting ACTION Node/Process Completion 
Notification (page12-53)

This step sets the name of an ACTION node and the 
alert setting whether it should be tuned on or off 
when the ACTION is completed.

6 Setting the Contents of a Recipe Sheet 
(page12-39)

This step sets the following items:
• Set a device to read
• Set a recipe write range

5 Specifying a Recipe Sheet and its Output File 
(page12-36)

This step sets the following items:
• Specify a recipe sheet
• Specify an output file

3 Registering Entry Nodes (page12-33) This step registers the PC and the display units as 
entry nodes.

1 Creating a Recipe Sheet (page12-32) This step creates a recipe sheet in 'Microsoft Excel' 
to write the data read from Device/PLC.

2 Starting 'Pro-Studio EX' (page12-33) This step starts 'Pro-Studio EX'.

4 Registering Symbols (page12-34) This step registers as a symbol the device of Device/
PLC from which data is read.
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12.2.1 Creating a Recipe Sheet

This step creates a recipe sheet to write the data read from Device/PLC.

1 Start 'Microsoft Excel' and create the recipe sheet below in Sheet 1.

[Creation Example]

Leave both spaces for "Symbol Name" (Cells B1 to F1) and those for "Record No." (Cells A2 to A4) blank for 

these will be automatically allotted and filled in after completing the setting.

2 Save the recipe sheet with the file name "recipe.xls" on PC desktop after creating.

• You can create a recipe sheet in the direction (horizontal) as shown below.

Recipe data

"Symbol Name" insert field

"No. of Records" insert field

Recipe data"Symbol Name" insert field

"No. of Records" insert field
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12.2.2 Starting 'Pro-Studio EX'

This step starts 'Pro-Studio EX'.

Refer to "3 Trial of Pro-Server EX" for details about starting method.

12.2.3 Registering Entry Nodes

This step registers the PC and the display unit connected with network as nodes.

Refer to "31 Node Registration" for details about entry nodes.

Entry Node Setting item Setting example

PC
Node Name PC1

IP Address 192.168.0.1

Display Unit

Type GP3000 series

Node Name AGP1

IP Address 192.168.0.100

Node Name  :PC1

IP Address  :192.168.0.1

Node Name  :AGP1

IP Address  :192.168.0.100

Device/PLC Information
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12.2.4 Registering Symbols

This step registers as a symbol the device address of Device/PLC to which device data is written.

Refer to "32 Symbol Registration" for details about symbols.

Device 

Address

M01 Start reading

 Symbol

Trigger (Trigger Condition)

Reading Device
 

 Device 

Address

D50

D51

D52

D53

D54

 PLC1 Data

 Symbol

Device 

Address

D10 Store record No

 Symbol

Record No. storage
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• Trigger (Trigger Condition)

• Record No. Storage

• Reading Device

Setting item Setting content

Symbol Name Start reading

Data Type Bit

Device address for 
symbol registration

"01" of Device/PLC (PLC1)

No. of Devices 1

Setting item Setting content

Symbol Name Record No. Storage

Data Type 16Bit (Unsigned)

Device address for 
symbol registration

"10" of Device/PLC (PLC1)

No. of Devices 1

Setting item Setting content

Symbol Name PLC1 data

Data Type 16Bit (Signed)

Device address for 
symbol registration

"D50" to "D54" of Device/PLC (PLC1)

No. of Devices 5
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12.2.5 Specifying a Recipe Sheet and its Output File

This step specifies the pre-created recipe sheet and its output file.

Refer to "12.3 Setting Guide" for more details.

1 Click the [Feature] icon on the status bar.

2 Select [ACTION] from the tree display on the left of the screen, then click the [Add] button.

Setting item Setting content

Specify a Template Template File
C:\Documents and 
Settings\Administrator\Desktop\recipe.xls

Output File

Folder Name C:\Documents and Settings\Administrator\Desktop

File Name Recipe read.xls

Start with the output 
file displayed

Checked

Do not save the output 
file when ACTION 
runs.

Not checked
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3 Click the [ACTION Type] list button, and select "Create form using Excel". 

Then, enter the name of ACTION to set in the [ACTION Name] field. In this example, enter "Recipe Read".

4 Click the [Click here to set the ACTION parameter] button.

5 Make settings regarding an Excel template and its output file.

1) Click the [Reference] button of [Template File] to set the template file "templete.xlt" which you created.

• [ACTION Name] can be an arbitrary name.
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2) Click the [Reference] button of [Folder Name] and specify "Desktop" as a folder to save the output file.

3) Set the file name "RecipeRead.xls" in the [File Name] field for the output file to set.

4) Check the [Start from Displayed State] check box.

• If you check [Start from Displayed State], you can read/write data with an output file displayed. 

This is useful if you need to confirm data immediately.
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12.2.6 Setting the Contents of a Recipe Sheet

This step sets the contents of a recipe sheet to write the data read from Device/PLC.

The example below shows the setting of data read area (recipe area) of a recipe sheet.

Refer to "12.3 Setting Guide" for more details.

1 Click the [Edit Template] button.

Setting item Setting content

Entry Node AGP1

Device Name PLC1

Device Address/Symbol 
Group

PLC1 data

Add Device Address/
Symbol Name

Checked

Target Cell Range A1 to F4

Data Direction Specify the direction of record No.s as "Vertical".

Trigger Condition Name Turn on write start bit

Trigger Condition When "Start writing" (M01) is ON

Target Cell Range

Data direction

Device address/Symbol name 

will be displayed.

Record No. will be inserted.
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2 Set a data read area.

1) Click the [Recipe Area] icon on Excel.

2) Click the list button of [Node] and select "AGP1" as a data transfer source node.

• Selecting "Recipe Area" from [Excel Action] of the menu displays the same screen. 
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3) Click the list button of [Device Name] and select "PLC1" as a data transfer source device.

4) Click the list button of [Device Address/Symbol Group] and select "PLC1 data" as a symbol of the data to 

read out.

The device number "1" will be automatically entered in [No. of Devices], and "16Bit(Signed)" in [Data Type].
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5) Check [Add Device Address/Symbol Name].

6) Click the cell range specify button of [Target Cell Range].

7) Drag the mouse to specify the data read area (cells A1 to F4). Then click the [OK] button.

• After the procedure of "12.2.9 Saving a Network Project File" described later, open the template 

again, and open the recipe setting dialog box. After confirming that the "Add Device Address/

Symbol Name" checkbox has been checked, click the [OK] button. Then, the device address/

symbol name will be reflected in the template.

• When specifying the area, cover the cells to insert record No.s and Device Address/Symbol Names. 
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8) Select "Vertical" of [Data Direction]. 

9) Click [Allot Record No. from 1 to Cell Range].

Record No.s and ruled lines are automatically added on the recipe sheet.

• Specify the recipe data to write in Device/PLC with record No.s This example allots record No.s to 

the recipe data.
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3 Specify a record No. 

Specify the recipe data area by entering a record No. in the symbol "Record No. storage" from display unit or 

Device/PLC. 

(Example) In case of storing device data "1" in the device "Record No. storage".

1) Click the [Record No. Settings] tab.

2) Click "Specify by device/symbol value" in [Record No. at Write Recipe].

• If you select [Specify by cell value], specify any cell on Excel. The number entered in the cell is 

recognized as the record No.

Refer to "12.3 Setting Guide" for more details.

10
20
30
40
50

D10 1

 Record No. storageD50
D51
D52
D53
D54

 Device data

Read data of record No. "1"
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3) Click the list button of [Node] and select the node name "AGP1" which has the Device/PLC to store the 

record No.

4) Click the list button of [Device Name] and select the Device/PLC "PLC1" to store the record No.

5) Click the list button of [Device Address/Symbol] and select the symbol name "Record NoStorage" of the 

device to store the record No.

The device data type "16Bit(Unsigned)" will be automatically entered in [Data Type].
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4 Set trigger conditions. 

1) Click the [Trigger Condition Settings] tab.

2) Click the [New Trigger Condition] button.

3) Click the [New Trigger Condition] button.

• You can also activate ACTION by placing a button on Excel from [New Trigger Button] and 

clicking it. Refer to "12.3 Setting Guide" for more details.
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4) Enter the trigger condition name "TurnOnReadStartBit" in [Trigger Condition Name], and select "AGP1" in 

[Node Name] as a name of the data transfer source. 

5) Click the [When Device ON] button in the [Condition 1] tab and select "PLC1" for the device name. 
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6) Click the [Device Address] list button and select "ReadStart" for the device symbol name which serves as the 

trigger. 

[Data Type] automatically appears after selection, too. 

7) Click the [OK] button.
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8) Click the [Close] button.

9) Click the blank line of [Clear Cel when the following condition is satisfied] and select "TurnOnReadStartBit" 

as a trigger condition.

10) Click the [OK] button.
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11) Click the [OK] button.

This is the end of the content settings of a recipe sheet.

• Here the dialog box will appear because no network project file is loaded to 'Pro-server EX'. This is 

not a problem, however.

The file will be loaded in "12.2.9 Saving a Network Project File" mentioned later.

• Can display Data/Time on an Excel sheet. 

"5.2 Writing Date/Time in a Form"

• Can display arrows on an Excel sheet. 

"5.3 Writing Arrows in a Form"

• Can display a trigger source node on an Excel sheet. 

"5.4 Writing Trigger Source Node Names in a Form"
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5 Close 'Excel'.

The following dialog box will appear, asking you if you want to save changes before closing. Click the [Yes] 

button.
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6 On the "Create form using Excel" screen, click the [OK] button.
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12.2.7 Setting ACTION Node/Process Completion Notification

This step sets the name of an ACTION node and the alert setting whether it should be tuned on or off when the 

ACTION is completed.

• ACTION Node : PC1

• Receive Notification: OFF

1 On the "Set ACTION Name/Parameter" screen, click the [Next] button.

2 Click the list button of [Action Node] and select "PC1" as a node where ACTION operates.
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3 Turn off the check box of [Receive Notification Exists], if checked.

4 Click the [Complete] button.

The "ACTION Node/Process Completion Notification Settings" screen will disappear. On the left of the screen, 

the name of ACTION you set will appear.

This is the end of the settings of the ACTION node and process completion notification. 

• Do not check "Receive Notification Exists".
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12.2.8 Verifying Setting Result

This step verifies setting results on the setting content list screen.

1 Select the ACTION name "RecipeRead" from the tree display on the left of the screen.

Confirm that the setting content appears on the right of the screen.

• In case of the "Excel Report" ACTION, you cannot add, edit or delete trigger conditions from 

"Trigger Condition/Process List per ACTION". To change the settings, click the [Parameters 

Settings] button and change the settings in [Edit Template] on Excel.
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2 Select the trigger condition name "TurnOnReadStartBit" from the tree display on the left of the screen.

Confirm that the setting content appears on the right of the screen.

This is the end of the verification of the settings.
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12.2.9 Saving a Network Project File

This step saves the current settings as a network project file and reloads to 'Pro-Server EX'.

Refer to "25 Saving" for details about saving a network project file.

• Path of network project file : Desktop\monitor.npx

• Title : EXCEL Report ACTION

12.2.10 Test Read

You can check if the settings are correct before transferring a created network project file to entry nodes.

When executing ACTION, the setting data is output to an output file. However, when executing a test read, it is 

reflected in a template file.

1 Click the [Feature] button.

2 Click "ACTION" from the tree display on the left of the screen, then click the [Edit] button.

3 On the "Set ACTION Name/Parameter" screen, click the [Click here to set the ACTION parameter] button.

4 On the "Create form using Excel" screen, click the [Edit Template] button.

5 With the ACTION area selected, click the [Test Read] icon.

The setup contents will be read in the template.

• 'Pro-Server EX' reads a created network project file, and then executes ACTION 
according to the settings in the file. The settings therefore need be saved in the network 
project file.

• Be sure to reload the network project file to 'Pro-Server EX'. If not, ACTION will not work.

• You do not necessarily have to perform a test read.

If you skip this, proceed to "12.2.11 Transferring a Network Project File".

• To perform a test read, it is necessary that 'Pro-Server EX', to which a created network 
project file has been loaded, is running.

• Refer to "6.4 Restrictions" for details about the restrictions on test reads.
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12.2.11 Transferring a Network Project File

This step loads a saved network project file to 'Pro-Server EX' and then transfers to entry nodes.

Refer to "26 Transferring" for details about transferring a network project file.

12.2.12 Executing ACTION

This step verifies that enabling a trigger condition activates ACTION, opens a recipe sheet (file name: "recipe 

read.xls"), and then writes the device data in the specified location on the sheet.

This is the end of the explanation of this ACTION.

• Be sure to transfer a network project file. If not, ACTION will not work.

• If error occurs, you can check the log in the Log Viewer. For more details, refer to "28.5 

Monitoring System Event Logs".

• If you want to achieve faster communication during ACTION, refer to "29 Tips for Faster 

Communication".
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12.3 Setting Guide

This section explains how to set each screen in detail.

12.3.1 "Creating form using Excel" Screen

" "Creating form using Excel" Screen"

12.3.2 "Recipe" Screen

 "Action Settings" Tab
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Setting item Setting content

Device Settings

Node

Selects a node which has a device to read/write data

• Clicking the [...] button can retrieve or add entry nodes.
• Selecting "(Trigger-Source Node)" will select the entry node that has triggered 

the action. 

Device Name

Selects a node which has a device to read/write data

• It is not necessary to set when the entry nodes are GP Series nodes and Pro-
Server EX nodes.

Device 
Address/
Symbol 
Group

Sets the device address or symbol to be used.
• When specifying a device address:
Enter directly from the Calculator icon.

• When specifying a symbol:
Select the symbol by clicking the list button.

• When setting non-sequential devices, be sure to specify a group symbol.

Data Type

• When specifying a device address:
Specify the data type.

• When specifying a symbol:
Data type automatically appears. 

No. of 
Devices

Displays the number of devices to read/write, automatically calculating it from 
the selected cell range.

• If a group symbol has been selected, the number will be "1".

Calculator icon

List button
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Device Settings

Add Device 
Address/
Symbol 
Name

Displays Device Address, Symbol Name, and/or Group Symbol Name above or 
on the left of the cells where the data is written, serving as a guide to identify the 
data.
For the display location, specify above or left in "Data Direction" mentioned later. 

Refer to the image figure shown in the lower right of the dialog box.
• Vertical

• Horizontal

Layout Settings

Target Cell 
Range

Specifies the cell range to which data will be written/read.
Clicking the button can select the cell range on Excel.

• For the process on  how to select cell ranges, refer to " Action Area Settings" 
in "5.1.2 Setting Guide".

• The useful function is available to check the specified cell range (Action 
area).Refer to " Action Area List" in "5.1.2 Setting Guide".

Data 
Direction

Sets the data write direction when selecting multiple cells.

• (Vertical)
Sequentially from top to bottom.

• (Horizontal)
Sequentially from left to right .

• The write image of the content set in "Layout Settings" appears in [Sample].

No. of 
Records

Sets and displays the number of records used for a recipe, automatically 
calculating it from the specified cell range.

Setting item Setting content



Setting Guide

Pro-Server EX Reference Manual 12-62

Allot Record No. from 1 to Cell 
Range

Automatically inserts record No.s in the area specified in [Data Direction] of 
[Target Cell Range]. 
It is possible to enter record No.s directly on Excel, but this could cause erroneous 
operation due to typing error. For this, we recommend entering with the [Allot 
Record No. from 1 to Cell Range] button.

• Clicking this button also inserts ruled lines in [Target Cell Range] 
automatically.

Setting item Setting content
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 "Record No. Settings" Tab

Setting item Setting content

Record No. at 
Write Recipe / 
Record No. at 
Read Actual 
Value

Specify by 
device/
symbol value

Specifies the recipe data by entering a record No. in the device or symbol specified 
by display unit or Device/PLC.

Node

Selects a node which has the device where a recipe record No. exists.

• Clicking the [...] button can retrieve or add entry nodes.
• Selecting "(Trigger-Source Node)" will select the entry node that has 

triggered the action. 
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Record No. at 
Write Recipe / 
Record No. at 
Read Actual 
Value

Specify by 
device/
symbol value

Device 
Name

Selects a Device/PLC which has the device where recipe record No.s 
exist.

• It is not necessary to set when the entry nodes are GP Series nodes and 
Pro-Server EX nodes.

Device 
Address
/Symbol

Sets the device address or symbol to be used.
• When specifying a device address:
Enter directly from the Calculator icon.

• When specifying a symbol:
Select the symbol by clicking the list button.

• When setting non-sequential devices, be sure to specify a group 
symbol.

Data 
Type

• When specifying a device address:
Specify the data type.

• When specifying a symbol:
Data type automatically appears. 

No. of 
Charact-
ers

Specifies the number of readable characters of a record No. when the 
specified data type of the record No. is "character string". 

Specify by cell value

Recognizes the entered value or character string in any specified cell on 
Excel, as a record No.
Therefore, you can select [Specify by cell value] on condition that you 
use recipe data in such environment as the office having PCs. 

• Be sure to place cells to specify record No.s on the same sheet as 
recipe data. 

Setting item Setting content

Calculator icon

List button
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 "Trigger Condition Settings" tab

Setting item Setting content

Action Area No. Displays No. allocated to each ACTION area by template.

New Trigger Condition
Displays the "Trigger Condition Settings" dialog box.
Click here to set a new trigger condition.

New Trigger Button
Displays the "Create Trigger Button" dialog box.
Refer to "5.6.2 Setting Guide" for more details.

Write

Selects a trigger condition to write recipe data.
Click the blank line of [Trigger Condition] and then the list button to display the registered 
trigger condition. 

• When plural trigger conditions have been specified, satisfying at least one of those 
conditions executes ACTION.

• Clicking the [Edit] button can edit the specified trigger conditions.
• Clicking the [Delete] button deletes the specified trigger conditions.
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Read

Selects a trigger condition to read recipe data.
Click the blank line of [Trigger Condition] and then the list button to display the registered 
trigger condition. 

• When plural trigger conditions have been specified, satisfying at least one of those 
conditions executes ACTION.

• Clicking the [Edit] button can edit the specified trigger conditions.
• Clicking the [Delete] button deletes the specified trigger conditions.

Setting item Setting content
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12.4 Restrictions

 Changing the Security Settings

To execute the Excel Form Creation Action, you need to change the Excel security settings. If you do not change 

the settings, the following problems will occur.

• [Tool]  [QC Chart]

Pareto graph tools cannot be used.

• [Tool]  [Insert Sample]

Form templates cannot be used.

The setting change steps vary depending on the Excel version.

Change the security settings according to the following steps.

 'Microsoft Excel 2000'

1 Click [Security] from [Macro] under the Excel [Tool] menu.

2 Check "Middle" or "Low" on the [Security Level] tab in the [Security] dialog box.

 'Microsoft Excel 2002' and 'Microsoft Excel 2003'

1 Click [Security] from [Macro] under the Excel [Tool] menu.

2 Check "Middle" or "Low" on the [Security Level] tab in the [Security] dialog box.

3 Check the [Trust Access to Visual Basic Project] option on the [Trusted Publisher] in the [Security] dialog box.

 ''Microsoft Excel 2007' or 'Microsoft Excel 2010'

1 'Microsoft Excel 2007': Click the [Office] button and [Excel Options].

'Microsoft Excel 2010': From the [File] tab, click [Options].

2 'Microsoft Excel 2007': Click [Popular] in the [Excel Options] dialog box.

'Microsoft Excel 2010': From the [Excel Options] dialog box, click [Customize Ribbon].

3 'Microsoft Excel 2007': Check the "Show Developer tab in the Ribbon" option.

'Microsoft Excel 2010': From the [Main Tabs] list, select the [Developer] check box.

4 Click [Macro Security] on the [Developer] tab.

5 Click [Macro Settings] in the [Trust Center] dialog box.

6 Check the [Enable all macros] option under [Macro Settings].
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7 Check the [Trust access to the VBA project object model] option.

 Combined Cells

Do not set an ACTION area on combined cells.

For example, if you set an ACTION area in the cells as shown below, correct operation cannot be guaranteed.

 Over-pasted ACTION Areas

When you over-paste plural ACTION areas of different size, read/write will be executed in the pasted order.

 Writing Data of Excel in the Device/PLCs

When the data type is "Character string", write null characters (NULL) in empty cells in Excel, and in the other 

cases write "0".  

 Writing Character String Data

When writing "Character string" data in Excel, format the cell(s) to write data in as "Character string".

 Excel Window 

If the setting screen is hidden behind the Excel window, the screen and task tray windows will blink and notify the 

user. Blinking will stop automatically when the setting screen comes forward.
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 Operation in ACTION area when error occurs

When you actually write/read in all the functions, such as "Device One-Shot" and "Device Logging", and exceed 

the ACTION area, perform the common operation as follows:

1) When performing a test read/ a test write

Error screen is displayed.

2) When executing ACTION in runtime 

It will be recorded as ACTION error in the log viewer of the 'Pro-Server EX'.

 In the case of closing the displayed output book

If you have mistakenly closed an output book of Excel Report ACTION, follow these steps to open it again: 

Dragging and dropping the book to open will make it read-only and the start button etc. invalid. 

1. Double-click the output book.

2. When the following dialog box appears, select "No" to open it.

 Receive notification

You cannot set the receive notification which indicates the completion of ACTION.

 When setting “Trigger-Source Node”

When setting "Trigger-Source Node" at node in Excel Report action, node type and device are uncertain.

Therefore, the device address is displayed in red.But, it is no problem.

 Edit the output file

While Excel Report Action is executing, you can not edit the output file.

Therefore, it becomes very difficult to operate Excel at the setting in which the Trigger condition satisfies at a 

short cycle.Moreover, the following error message is displayed when the Action is executed during editing the 

output file.

 Save the output file Do not use

Do not use multiple Excel form actions to save output files to the same destination.

If you set the same destination for file outputs, Pro-Studio and Pro-Server EX may not be able to run.
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 About the 1500 row limit for Action Area settings

Exceeding 1500 rows for the Action Area could cause the action to run longer. If you use Device One Shot or  

Device Logging's text conversion, the action could take even longer.

 Restrictions on Copying or Cutting and Pasting the Action Area

When you paste the Action area using Ctrl+C & Ctrl+V or Ctrl+X & Ctrl+V, specify [Target Cell Range] for the 

copied Action area.

The Action area just after pasting remains the same [Target Cell Range] as that for the original Action area.

 Excel Auto Save Function

The Excel auto save function does not operate due to the Excel restrictions.To save automatically, create the Excel 

save macro using the following procedure and execute the created save macro by Action.

1 Open a template you want to save automatically using 'Pro-Studio EX'.
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2 Select "Macro" and "Record New Macro" from the "Tools" menu.

3 Enter the macro name "Macro1" and click the [OK] button.

Recording the macro starts.

4 Select "Save" from the "File" menu.

"Macro1" is recorded in the macro.
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5 Select "Macro" and "Stop Recording" from the "Tools" menu.

Recording the macro is complete.

6 Select "Execution Sequence List" from the "Excel Action" menu.

7 Create the trigger condition save automatically.
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8 Select the created trigger condition and "Excel Operation Function".

9 Select "Execute Macro" and enter the macro name "Macro1".

10 Click the [OK] button.

11 Finish editing the template.

12 Save/Reload the setting contents.

According to the created trigger condition, the template is automatically saved.
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